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1. INTRODUCTION 

Thank you for purchasing this LEADER instrument. To use this instrument safely, read this 

instruction manual thoroughly, and make sure that you know how to use the instrument 

properly. 
 

If some point about the operation of this instrument is still unclear after you have read this 

instruction manual, refer to the contact information on the back cover of the manual to contact 

LEADER, or contact your local LEADER agent. 

After you have finished reading this manual, keep it in a convenient place so that you can refer 

to it when necessary. 
 

1.1 About Licenses 

This software can only be used after its license key has been activated. After you have 

installed this software on a PC, connect the PC to an LG 3860, and then enter the license key 

from the PC. For details on installing the software and entering the license key, see the LG 

3860 instruction manual. 
 

The license key for this software can only be used on one LG 3860. You cannot install this 

software on multiple LG 3860s. 
 

1.2 Operating Precautions 

1.2.1 About Turning the Power Off 

When a PC and an LG 3860 are connected by a USB cable and you want to turn the 

devices off, be sure to turn the LG 3860 off before you turn the PC off. 
 
1.2.2 About the PC Setting 

When you are controlling the LG 3860 from a PC, do not set the PC to power saving mode. 
 
1.2.3 About Transport Stream File Playback 

If you play back a transport stream file from a PC that is handling an excessive load, the 

video or audio may be interrupted. 
 
1.2.4 About the USB Connection 

While the program is being transferred from the PC to the LG 3860, do not disconnect the 

USB connection between the PC and the LG 3860. If a disconnection of the USB cable or 

other problem causes the program transfer to be interrupted, transfer the program to the 

LG 3860 again. 
 

If, while the LG 3860 is being controlled from a PC, the USB connection is mistakenly 

disconnected, an error message is displayed on the PC screen. If this happens, re-connect 

the USB connection, and then click the play button on the control application to begin 

transmitting the signal again. 
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1.3 Trademarks 

The company and product names in this document are trademarks or registered trademarks 

of their respective holders. 
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2. SPECIFICATIONS 

2.1 General 

This product is a software application that can be used to transfer broadcast systems to the 

LG 3860 and control the LG 3860 from a PC. After a broadcast system has been transferred 

to the LG 3860, the LG 3860 can be used as a DVB-S/S2 signal generator. 
 

2.2 Features 

● USB 2.0 

Connect the LG 3860 to a PC through USB to transfer broadcast systems, play back 

user-defined transport streams, and configure transmission parameters. 
 

● Still Images 

Output two different still-image patterns seamlessly. 
 

● Audio Signals 

Select from three different audio patterns. 
 

2.3 Specifications 

2.3.1 Broadcasting System 

DVB-S (EN 300 421) 

Modulation Format QPSK 

Coding Rate 

Inner Code Convolutional coding R = 1/2, 2/3, 3/4, 5/6, 7/8 

Outer Code RS(204,188) 

Roll-Off Factor √0.35 

Symbol Rate 1 to 35 Msps (in 0.0001 Msps steps) 
 

DVB-S2 (EN 302 307) 

Modulation Format QPSK, 8PSK, 16APSK, 32APSK 

Coding Rate 

Inner Code 

QPSK LDPC coding R = 1/2, 3/5, 2/3, 3/4, 5/6, 8/9, 9/10 

8PSK LDPC coding R = 3/5, 2/3, 3/4, 5/6, 8/9, 9/10 

16APSK LDPC coding R = 2/3, 3/4, 4/5, 5/6, 8/9, 9/10 

32APSK LDPC coding R = 3/4, 4/5, 5/6, 8/9, 9/10 

Outer Code BCH coding 

(32400,32208) LDPC coding R = 1/2 

(38880,38688) LDPC coding R = 3/5 

(43200,43040) LDPC coding R = 2/3 

(48600,48408) LDPC coding R = 3/4 

(51840,51648) LDPC coding R = 4/5 

(54000,53840) LDPC coding R = 5/6 

(57600,57472) LDPC coding R = 8/9 

(58320,58192) LDPC coding R = 9/10 

Frame Length Normal (64800 bits) 

Pilot Insertion ON, OFF 
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Roll-Off Factor √0.35, √0.25, √0.20 

Symbol Rate 1 to 35 Msps (in 0.0001 Msps steps) 
 

* Broadcasting system and parameters can be switched when the LG 3860 is connected to a PC. 

 
2.3.2 External TS Input Specifications 

Input Packet Format 188 bytes, 204 bytes 

Supported Stream MPEG-2 TS (ISO/IEC13818-1) 

Input Data Rate 0.2 to 75.0 Mbps 
 
2.3.3 RF Signal Generator 

Output Level 39 to 99 dBμV (75 Ω termination; in 1 dB steps) (*1) 

Output Frequency 950 to 2150 MHz 

Frequency Resolution 10 kHz 
 

*1 This is the guaranteed operating range. The optimal range is 59 to 99 dBμV (75 Ω termination).If 

signals in the range of 39 to 58 dBμV (75 Ω termination) will be generated, we recommend that an 

external attenuator be connected to the LG 3860. 

 
2.3.4 Internal Signal 

Pseudo Random Signal PN23, PN15 (*1) 

Still-Image Pattern Color bar, monoscope 

Format / Frame 1920×1080i / 30 fps (HDTV),  

1920×1080i / 25 fps (HDTV) (*1) 

Audio (Tone) 1 kHz (LR), 400 Hz (LR), 1 kHz (L) + 400 Hz (R) (*1) 
 

* The still-image patterns and formats may be changed. 

*1 The pseudo random signal, frame, and audio (tone) can be switched when the LG 3860 is connected 

to a PC. 

 
2.3.5 C/N Generator 

C/N Adjustment Range 5.0 to 30.0 dB (*1) 

Resolution 0.1 dB 
 

*1 The C/N setting can be adjusted when a PC is connected. 

 
2.3.6 PC Operating Environment 

OS Windows 7, Windows Vista, Windows XP SP3 

CPU Intel (R) Celeron (R) M 1.4 GHz or more 

Memory 512 MB or more 

HDD 1 GB or more of free space 

USB Port 1 USB 2.0 port 
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2.3.7 Standalone Operation of the LG 3860 

Function Through the transferring of a broadcast system to the LG 

3860, the LG 3860 can be used as a standalone 

DVB-S/S2 signal generator. 

RF Signal Generator 

Output Level 39 to 99 dBμV (75 Ω termination; in 1 dB steps) 

Output Frequency 950 to 2150 MHz (in 10 kHz steps) 

Internal Signal 

Pseudo Random Signal PN23, PN15 

Still-Image Pattern Color bar, monoscope 

Format / Frame 1920×1080i / 30 fps (HDTV), 

1920×1080i / 25 fps (HDTV) 

Audio (Tone) 1 kHz (LR), 400 Hz (LR), 1 kHz (L) + 400 Hz (R) 

Presets 

Recall/Store Stores and recalls presets (*1) 

Alarm Display Shown on the 7-segment display 
 

*1 If a preset recall range has been set through the use of the control application, presets from within 

that range are recalled. 

 
2.3.8 Control Application 

Function Controls the LG 3860 from a PC over a USB connection 

Broadcasting System DVB-S, DVB-S2 

Symbol Rate 1 to 35 Msps (in 0.0001 Msps steps) 

Modulation Format 

DVB-S QPSK 

DVB-S2 QPSK, 8PSK, 16APSK, 32APSK 

Coding Rate 

DVB-S R = 1/2, 2/3, 3/4, 5/6, 7/8 

DVB-S2 R = 1/2, 3/5, 2/3, 3/4, 4/5, 5/6, 8/9, 9/10 

Pilot Insertion (DVB-S2) ON, OFF 

Roll-Off Factor (DVB-S2) √0.35, √0.25, √0.20 

RF Signal Generator 

Output Level 39 to 99 dBμV (75 Ω termination; in 1 dB steps; can be 

turned on and off) 

Output Control Modulation, carrier 

Output Frequency 950 to 2150 MHz (in 10 kHz steps) 

Internal Signal 

Pseudo Random Signal PN23, PN15 

Still-Image Pattern Color bar, monoscope 

Format / Frame 1920×1080i / 30 fps (HDTV), 

1920×1080i / 25 fps (HDTV) 

Audio (Tone) 1 kHz (LR), 400 Hz (LR), 1 kHz (L) + 400 Hz (R) 

C/N Generator 

C/N Adjustment Range 5.0 to 30.0 dB (in 0.1 dB steps; can be turned on and off) 

Transport Stream File Operations 

Select, playback, stop, etc. 



2. SPECIFICATIONS 

6 

Presets 

Recall/Store Stores and recalls presets 

Begin/End Sets the beginning and ending preset numbers on the 

LG 3860 

Load/Save Collectively saves and writes 40 presets 

Alarm Display Can't connect to USB device, etc. 
 
2.3.9 Licenses 

License Activation When the program is transferred to the LG 3860 
 

* The license key for this software can only be used on one LG 3860. 

 
2.3.10 General Specifications 

Environmental Conditions Same as the LG 3860 

Contents CD-ROM (Software, instruction manual) ..................... 1 

License key (A4 sheet) ................................................ 1 
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3. INSTALLATION 

To use this software, follow the procedure below. For details, see the LG 3860 instruction 

manual. 
 

1. Install the encoding software. 

Install the encoding software on your PC from the CD-ROM. 

To update the encoding software, uninstall the old version, and then install the new version. 
 

2. Install the USB driver. 

Install the USB driver on your PC. 

This software supports Microsoft Windows XP SP3, Windows Vista, and Windows 7. 

Follow the procedure below to install the USB driver on these operating systems. 
 

The installation procedure explained here is for Windows XP SP3. Depending on your PC, 

your screens may differ slightly from the screen captures shown in this procedure, but the 

procedure remains the same. 
 

a) Turn on the LG 3860. 

b) Use a USB cable to connect the LG 3860 rear-panel USB port to a USB port on your PC. 

Do not connect devices other than the LG 3860 to the other USB ports on your PC. 
 

c) If the Windows Update connection window appears, select “No, not this time,” and click 
Next. 

 

Figure 3-1  Windows Update connection window 
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d) When the installation window appears, select “Install from a list or specific location,” and 
click Next. 

 

Figure 3-2  Installation window 
 

e) When the following screen appears, select “Search for the best driver in these locations,” 
and click Browse. 

 

Figure 3-3  Driver search window 
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f) Select the wxp folder of the encoding software that was installed during step 1, “Install 
the encoding software,” and then click OK. 

On Windows Vista or Windows 7, select the wlh folder. 
 

 

Figure 3-4  Browse For Folder dialog box 
 

g) Check that the full path displayed here is the folder that you selected in step f, and then 
click Next. 

When you click Next, the PC searches for and installs the driver. This process may 

take some time. 
 

 

Figure 3-5  Driver folder confirmation window 
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h) If any warnings that are related to the hardware installation appear, click Continue 
Anyway. 

This dialog box may not appear. 
 

 

Figure 3-6  Hardware installation warning dialog box 
 

i) When the following window appears, the installation is complete. Click Finish. 

 

Figure 3-7  Installation complete window 
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3. Activate the license and transfer the program to the LG 3860. 

Connect the LG 3860 to your PC, and activate the license. 

After the license has been activated, you can use the LG 3860 as a standalone DVB-S/S2 

signal generator. 

See section 5.3.5, “LG 3860” and chapter 4, “STANDALONE OPERATION OF THE LG 3860.” 

 

The LG 3860 can be controlled from a PC. By controlling the LG 3860 from a PC, you can play 

back external TS files and configure detailed settings that are used during LG 3860 standalone 

operation. 

Use the application software LG 3860SER02 DVB-S/S2 Remote Control to control the LG 3860. 

In this manual, this software is referred to as the “control application.” 

See chapter 5, “CONTROL APPLICATION.” 
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4. STANDALONE OPERATION OF THE LG 3860 

This chapter will explain how to operate the LG 3860 as a standalone device. To operate the LG 

3860 in this manner, you must first connect the PC to the LG 3860 and transfer the DVB-S/S2 

signal generator program to the LG 3860. 

See chapter 3, “INSTALLATION.” 

 

4.1 Panel Settings 

4.1.1 PATTERN 

Press each of the front-panel PATTERN keys to play back the internal still-image patterns 

and PN signals. 

See section 5.3.2, “Pattern.” 
 

COLOR BAR: A colorbar signal is transmitted (30 fps/25 fps). 

MONOSCOPE: A monoscope signal is transmitted (30 fps/25 fps). 

PN: A pseudo random signal is transmitted (PN23/PN15). 

OTHERS: Not used. 

 
4.1.2 CHANNEL 

Press the front-panel CHANNEL key to set the output frequency. When the channel is 

being selected, “CH” lights, and the output frequency is displayed on the 7-segment LED. 
 

Set the output frequency in groups of two digits for 100 MHz, 1 MHz, and 10 kHz. Use the 

BAND key to select a group of two digits. For example, if you want to set the output 

frequency to 1234.56 MHz, set SAT 1 to 12, SAT 2 to 34, and SAT 3 to 56. 
 

Press the ▼ and ▲ keys to select the output frequency. Hold down the ▼ or ▲ key to 

switch the setting quickly. You can set the output frequency to a value that is in the range of 

950 to 2150 MHz. 
 
4.1.3 BAND 

Press the front-panel BAND key to switch between the output frequency digits. 
 

SAT 1: Selects the 100 MHz digit. 

SAT 2: Selects the 1 MHz digit. 

SAT 3: Selects the 10 kHz digit. 

 
4.1.4 LEVEL 

Press the front-panel LEVEL key to set the output level. When the level is being set, “dBμV” 

lights, and the output level is displayed on the 7-segment LED. 
 

Press the ▼ and ▲ keys to set the output level. Hold down the ▼ or ▲ key to switch the 

setting quickly. You can set the output level to a value that is in the range of 39 to 99 dBμV 

(75 Ω termination) in steps of 1 dB. 
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4.1.5 STORE/RECALL 

You can save and recall 40 preset configurations (stored in preset addresses 00 to 39). For 

details, see the LG 3860 instruction manual. 

If you use the control application to set the range of presets that can be recalled, you can 

only recall the presets within the range that you set. 
 

Use the control application to save the following values to presets. 

The Fixed Setting, PN Setting, TS Setting, and C/N 

See sections 5.3.5, “LG 3860” and 5.4.2, “Preset No./Store/Recall.” 
 

* When the LG 3860 turns on, it transmits a signal based on the settings in the preset of the address 

specified by Begin No. within the preset recall range that you have set with the control application. 

 

4.2 Settings at Power On 

When the LG 3860 turns on, it uses the settings that are stored in the first preset address 

(Begin No.). It also uses these settings if you disconnect the connection with the PC while 

using the control application. Immediately after you transfer the program to the LG 3860, the 

first preset address is number 00. 
 

The factory default values of this preset are shown below. 
 

Table 4-1  Factory default values of presets 

Item Factory Default 

System DVB-S2 

Modulation 8PSK 3/4 

Roll-off Alpha 0.35 

Symbolrate 8.0000 Msps 

Transmission Parameters 

Pilots Enabled 

 COLOR BAR (30 fps) PATTERN 

AUDIO L: 1 kHz R: 400 Hz 

FREQUENCY 950MHz 

LEVEL 70 dBμV (75 Ω termination) 

 OFF Noise 

C/N 10.0 dB 

 



5. CONTROL APPLICATION 

14 

5. CONTROL APPLICATION 

This chapter will explain the control application LG 3860SER02 DVB-S/S2 Remote Control that 

you use to control the LG 3860 from a PC. To control the LG 3860 from a PC, you must first 

transfer the DVB-S/S2 signal generator program to the LG 3860 from a PC. 

See chapter 3, “INSTALLATION.” 

 

5.1 Starting and Ending Remote Control 

● Starting the control application 

Use a USB cable to connect the PC and LG 3860, and then follow the procedure below 

to start the control application. 

On the taskbar, click Start, All Programs, LEADER, LG 3860SER02, and then click LG 

3860SER02 DVB-S,S2 Remote Control. 
 

● Starting remote control 

When one LG 3860 is connected to the PC, the LG 3860 is automatically detected by the 

control application when the application starts, and you can immediately control this LG 

3860. 

When more than one LG 3860 is connected to the PC, carry out the procedure below to 

select the LG 3860 to control. To control multiple LG 3860s from a single PC, run multiple 

control applications. 
 

Controlling the first LG 3860 

• If you have previously controlled one of the connected LG 3860s, that LG 3860 will be 

automatically detected. 

• If you have not previously controlled one of the connected LG 3860s, the Connect list 

in the main window displays “Select.” Remote control does not start until you select an 

LG 3860. Select the serial number of the LG 3860 that you want to control from the list. 
 

 

Figure 5-1  Main window 
 

Controlling the other LG 3860s 

For the other LG 3860s, the Connect list in the Main window will display Select again, 

and the serial numbers of LG 3860s that are not controlled will be displayed. Select the 

serial number of the LG 3860 that you want to control from the list. 
 

If all the LG 3860s are being controlled and you start another control application, the 

following error message appears: “No Connection.” If this happens, exit the control 

application. 
 

You cannot play back transport stream files with the same file name on multiple control 

applications. 
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● During remote control 

During remote control, The LG 3860 7-segment LED displays “PC.” When the LG 3860 

is in this state, you cannot perform panel operations. 
 

● Ending remote control 

Exit the control application on the PC to enable panel operations on the LG 3860. 

After the LG 3860 is disconnected from the PC, the LG 3860 uses the settings in the 

preset specified by Begin No. 
 

5.2 Window Explanation 

The control application window is explained below. 
The part containing the elements labeled 1 to 13 is referred to as the Main window. The part 

containing the elements labeled 15 to 20 is referred to as the Sub window. The Sub window is 

not displayed when you start the control application. To display the Sub window, click  (No. 

14) in the lower right of the screen. 
 

1

2

3

4

15

10

17

18 2221 20

14

2316

5

6

7

8

9

11

12

13

19  

Figure 5-2  Window explanation 



5. CONTROL APPLICATION 

16 

1 Title 

The title of the control application is displayed here. As shown in the above figure, you 

can see that this is a DVB-S/S2 application. 
 

2 Menu bar 

The menus that are used to configure various settings are displayed here. 

See section 5.3, “Menu Bar.” 
 

Table 5-1  List of menus 

Menu Description 

File Click to select the playback file or to exit the application. 

Pattern Click to select the output pattern. 

Controls Click to select the LG 3860 that you want to control or to configure file playback settings.

Preset Click to collectively store, write, and list presets. 

LG 3860 Click to perform license activation, program transfer, preset-recall-range configuration, 

and to display information about the controlled LG 3860. 

Help Click to display information about the application. 

 

3 Toolbar 

Use the controls displayed here to select the output pattern, and store and recall presets. 

See section 5.4, “Toolbar.” 
 

4 Connect 

Select the serial number of the LG 3860 that you want to control. If no LG 3860 is 

selected, “Select” is displayed. 

See section 5.5.1, “Connect.” 
 

5 File 

The selected file is displayed here. You can also enter the full path directly. 

See section 5.5.2, “File.” 
 

6 Playback slider 

The playback status of the selected file is displayed here. You can skip parts of the file by 

moving the slider. 

See section 5.5.3, “Loop/Slider/Time.” 
 

7 Play button 

Starts the playback of the selected file. During file playback, this button switches to the 

pause button. You can operate the play button when a transport stream file has been 

selected. 

See section 5.5.4, “Play/Pause/Stop.” 
 

8 Stop button 

Stops the playback of the selected file. You can operate the stop button when a transport 

stream file has been selected. 

See section 5.5.4, “Play/Pause/Stop.” 
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9 Alarm button 

This is displayed when any problem, such as an improper USB disconnection, occurs. 

Click this button to display a message. When you solve the problem, this button 

disappears. 
 

10 Detailed Setting 

Click to configure various settings for the selected file. The settings that you can 

configure differ depending on the selected file. 

See section 5.5.5, “Detailed Setting.” 
 

11 File button 

Click to select the playback file. You can also enter the full path in the text box directly or 

drag the file to the control application window. 

See section 5.5.2, “File.” 
 

12 Loop button 

Click to set the loop mode (repeat or only once) for the selected file. 

You can operate the loop button when a transport stream file has been selected. 

See section 5.5.3, “Loop/Slider/Time.” 
 

13 Time 

The selected file's playback time and total playback time are displayed here. 

See section 5.5.3, “Loop/Slider/Time.” 
 

14 Sub-window show/hide button 

Shows or hides the sub window. 
 

15 Frequency 

Set the output frequency. 

See section 5.6.1, “Frequency.“ 
 

16 Frequency slider 

Move the slider to set the output frequency. 

See section 5.6.1, “Frequency.“ 
 

17 RF 

Turn signal output on or off. 

See section 5.6.2, “RF.” 
 

18 Level 

Set the output level. 

See section 5.6.3, “Level.” 
 

19 Level slider 

Move the slider to set the output level. 

See section 5.6.3, “Level.” 
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20 Output 

Set the output signal to modulation or carrier. 

See section 5.6.6, “Output.” 
 

21 Noise 

Turn noise on or off. 

See section 5.6.4, “Noise.” 
 

22 C/N 

Set the C/N. 

See section 5.6.5, “C/N.” 
 

23 C/N slider 

Move the slider to set the C/N. 

See section 5.6.5, “C/N.” 

 

5.3 Menu Bar 

5.3.1 File 

Click the File menu to select the playback file or to exit the application. 
 

 

Figure 5-3  File menu 
 

● Open 

Displays the Open File dialog box. Select the playback file in this dialog box. 

The selected file is immediately played back. 
 

 

Figure 5-4  Open File dialog box 
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You can select a transport stream file or pattern file in the Open File dialog box. The 

four available pattern files are shown in the figure above. You cannot play back pattern 

files that you create. 
 

You can also enter the full path in the File text box on the Main window to select a file. 

See section 5.5.2, “File.” 
 

● Exit 

Exits the application. You can also exit the application by clicking the Close button in 

the upper right of the window. 
 
5.3.2 Pattern 

Click the Pattern menu to select the output pattern. The selected pattern is immediately 

played back. 
 

You can also select the output pattern from the toolbar. 

See section 5.4.1, “Pattern Buttons.” 
 

 

Figure 5-5  Pattern menu 
 

● Colorbar ● Monoscope 

A colorbar (simple animation) signal A monoscope signal is played back. 

is played back. 
 

  
 

● PN23 

A pseudo random signal (PN23) is played back. 
 

● PN15 

A pseudo random signal (PN15) is played back. 
 

● TS 

The previously selected transport stream file is played back. If no transport stream file 

has been selected, the Open File dialog box is displayed. Use this dialog box to select 

the file that you want to play back. 
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5.3.3 Controls 

Click the Controls menu to select the LG 3860 that you want to control or to configure file 

playback settings. 

You can select the file playback commands when a transport stream file has been selected. 
 

 

Figure 5-6  Controls menu 
 

● Connect 

Select the serial number of the LG 3860 that you want to control. A check mark is 

displayed next to the selected LG 3860. 

You can also select the LG 3860 to connect to from the Connect list on the Main 

window. 

See section 5.5.1, “Connect.” 

 

● Loop 

Click to set the loop mode to Repeat or Only once for the selected file. 

You can also click the loop button on the Main window to set the loop mode. 

See section 5.5.3, “Loop/Slider/Time.” 

 

● Play 

Starts the playback of the selected file. During playback, this command does not 

appear. 

You can also click the play button on the Main window to play back the selected file. 

See section 5.5.4, “Play/Pause/Stop.” 

 

● Pause 

Pauses the playback of the selected file. While the playback is paused, this command 

does not appear. 

You can also click the pause button on the Main window to pause the playback of the 

selected file. 

See section 5.5.4, “Play/Pause/Stop.” 

 

● Stop 

Stops the playback of the selected file. 

You can also click the stop button on the Main window to stop the playback of the 

selected file. 

See section 5.5.4, “Play/Pause/Stop.” 
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● Timer 

If a transport stream file has been selected, TS playback begins when the specified 

time and the time on the PC match. If the TS is already being played back, it is 

stopped and restarted. 

To enable this setting, select the TS Start Time check box, and then enter the time that 

you want to start playback. You can specify a time from 00:00:00 to 23:59:59. 
 

 

Figure 5-7  TS playback start time setup dialog box 
 
5.3.4 Preset 

Click the Preset menu to collectively store, write, or list presets. 

While a transport stream file is being played back, you cannot select these commands. 

For an explanation of presets, see the LG 3860 instruction manual. 
 

 

Figure 5-8  Preset menu 
 

● Save 

You can store presets 00 to 39 together in a single file. Set the filename and save 

location in the Save File dialog box, and then click Save. 
 

 

Figure 5-9  Save File dialog box 
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● Load 

Click to load a preset data file (presets 00 to 39) that was previously saved through the 

Save command to the LG 3860 that you are controlling. Select the file in the Open File 

dialog box, and then click Open. 

Note that any existing presets on the LG 3860 that you are controlling will be 

overwritten. 
 

 

Figure 5-10  Open File dialog box 
 

● Information 

Displays a list of presets (00 to 39) that have been saved through the Save menu. 

Select the file in the Open File dialog box, and then click Open. 
 

 

Figure 5-11  Preset selection dialog box 
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The Information window appears. 

In this window, you can double-click items to change the preset settings. 

After changing the settings, on the File menu, click Save to save the changes. 

Click Open in the File menu to change the file to display in the list. 
 

 

Figure 5-12  Information window 
 
5.3.5 LG 3860 

Click the LG 3860 menu to perform license activation, program transfer, preset-recall-range 

configuration, and to display information about the controlled LG 3860. 
 

 

Figure 5-13  LG 3860 menu 
 

● License 

Click to activate your license key. To use the features of this product, you must first 

activate the license key. For details, see the LG 3860 instruction manual. 

If the license key has already been activated on the LG 3860 that you are controlling, 

you cannot select this command. 
 

 

Figure 5-14  Input License dialog box 
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● Transfer Program 

Click to transfer the program to the LG 3860 that you are controlling. After the program 

transfer is complete, you can use the LG 3860 as a DVB-S/S2 signal generator. 

(If the program has already been transferred to the LG 3860 that you are controlling, 

you cannot select this command.) 
 

To begin transferring the program, click Execute in the Transfer Program dialog box. If 

your PC is connected to multiple LG 3860s, be sure that you have selected the LG 

3860 that you want to transfer the program to from the Connect list on the Main 

window before you begin the program transfer. 
 

 

Figure 5-15  Transfer Program dialog box 
 

During the program transfer, do not turn the LG 3860 off or disconnect the USB cable. 

If a disconnection of the USB cable or other problem causes the program transfer to 

be interrupted, transfer the program to the LG 3860 again. It takes about 30 minutes to 

transfer the program. 
 

 

Figure 5-16  Dialog box while the program is being transferred 
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● Config 

Set the preset recall range for when you operate the LG 3860 by itself. Enter the 

beginning and ending preset numbers in the Config dialog box, and then click OK. The 

factory default beginning and ending preset numbers are 0 and 39 respectively. 
 

Specify an End No. value that is larger than the specified Begin No. value. If you 

specify a preset number that is outside of the range, the following error message 

appears: “Preset Begin/End Input Error.” Enter an appropriate number. 
 

The settings made here are invalid when you use the control application to recall 

presets. You can use the control application to recall all presets (preset numbers 0 to 

39). 
 

 

Figure 5-17  Config dialog box 
 

● Information 

Click to display the information of the LG 3860 that you are controlling. 

While a transport stream file is being played back, you cannot select this command. 
 

 

Figure 5-18  Information dialog box 

Transfer status of the program (SER02 is displayed if the
program has already been transferred to the LG 3860.)

License key activation status (PASS is displayed if the
license key has been activated.) 
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5.3.6 Help 

Click the Help menu to display the information about the application. 
 

 

Figure 5-19  Help menu 
 

● About LG 3860SER02 

Click this to display a dialog box that contains information about the application, such 

as its version. 
 

 

Figure 5-20  About LG 3860SER02 dialog box 
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5.4 Toolbar 

5.4.1 Pattern Buttons 

Click the button that corresponds to the output pattern that you want to select. The selected 

pattern is immediately played back. 
 

You can also select the output pattern from the Pattern menu. 

See section 5.3.2, “Pattern.” 
 

 

Figure 5-21  Pattern buttons 
 
5.4.2 Preset No./Store/Recall 

You can use the preset toolbar to store and recall presets. 

The settings that are stored and recalled are the Pattern, Fixed Setting, PN Setting, TS 

Setting, Channel, Level, and C/N. 
 

 

Figure 5-22  Preset toolbar 
 

● Storing presets 

To store a preset, on the toolbar, enter a preset number next to Preset No., and then 

click Store. When the following confirmation message appears, click Yes to store the 

preset on the LG 3860. 
 

 

Figure 5-23  Confirmation dialog box 
 

Notes 

• You cannot store presets when you have selected a transport stream file. 

• Preset contents that are stored in the manner outlined above are retained even 

after the LG 3860 is turned off. 
 

● Recalling presets 

To recall a preset, on the toolbar, enter a preset number next to Preset No., and then 

click Recall. The preset that has been stored on the LG 3860 is recalled, and the 

settings of the selected preset are displayed in the control application. 
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5.5 Main Window 

5.5.1 Connect 

Select the serial number of the LG 3860 that you want to control. The serial numbers of the 

LG 3860s that are connected to the PC are displayed in the list. 
 

 

Figure 5-24  Displaying the list of LG 3860s that you can control 
 
5.5.2 File 

Select the file to play back. Use one of the following three methods to select the file. 

In addition to the methods listed here, you can also click the File menu to select the file. 

See section 5.3.1, “File.” 

 

● Click the file button 

 
 

Click the file button, and then select the file from the Open File dialog box that appears. 

The selected file is immediately played back. 
 

You can select a transport stream file or pattern file in the Open File dialog box. The 

four available pattern files are shown below. You cannot play back pattern files that 

you create. 

Colorbar, Monoscope, PN23, PN15 
 

● Enter the full path directly into the text box 

You can directly enter the full path to the file in the text box in the Main window. 

If the file specified by the full path that you entered can be played back, it is played 

back immediately. 
 

● Drag a file to the application 

You can play back a file by dragging it to the control application window. However, you 

cannot drag files from the Open File dialog box. 
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5.5.3 Loop/Slider/Time 

Use these elements to configure file playback settings. 
 

● Loop 

Click to set the loop mode (repeat or only once) for the selected file. 

You can use the following loop buttons when a transport stream file has been selected. 
 

 Repeat 
 

 Only once 

 

● Slider 

The playback status of the selected file is displayed here. You can skip parts of the file 

by moving the slider. 
 

● Time 

The selected file's playback time and total playback time are displayed here. 
 
5.5.4 Play/Pause/Stop 

When a transport stream file has been selected, click these buttons to play back the file 

and pause and stop the playback. 
 

● Play 

Click the play button to start the playback of the selected file. 

During file playback, this button switches to the pause button. 
 

 Play button 

 

● Pause 

Click the pause button to pause the playback of the selected file. 

While file playback is paused, this button switches to the play button. 
 

 Pause button 

 

● Stop 

Click the stop button to stop the playback of the selected file. 
 

 Stop button 
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5.5.5 Detailed Setting 

Click to configure various settings for the selected file. To display the dialog box for the 

selected settings, click the  button in the upper right of the window. The settings that you 

can configure differ depending on the selected file. 
 

 

Figure 5-25  Detailed Setting list 
 

● Fixed Setting 

When an internal still-image pattern (excluding pseudo random signals) has been 

selected, use this dialog box to select the frame rate and output audio. Click Apply to 

apply the settings. 
 

 

Figure 5-26  Fixed Setting dialog box 
 

Frame rate 

30fps: A 30-frame pattern signal is generated. 

25fps: A 25-frame pattern signal is generated. 
 

Audio 

1kHz(L) + 400Hz(R): A tone signal (left: 1 kHz and right: 400 Hz) is generated. 

1kHz(L,R): A tone signal (left and right both 1 kHz) is generated. 

400Hz(L,R): A tone signal (left and right both 400 Hz) is generated. 
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● PN Setting 

When an internal pseudo random signal has been selected, use this dialog box to 

select its polarity and its packet type. 

Click Apply to apply the settings. 
 

 

Figure 5-27  PN Setting dialog box 
 

PN Polarity 

Normal: A polarity that enables error measurement on generic BER 

measuring instruments is used. 

Inverted: The inverse of the Normal polarity is used. 
 

Packet Type 

Sync + PRBS: Sync (47hex) + 187-byte PN 

Header + PRBS: Sync (47 hex) + 1FFF (hex) + 10 (hex) + 184-byte PN 
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● TS Setting 

Use this dialog box to configure transmission parameters. 

Click Apply to apply the settings. 
 

If the transmission rate (Useful Bitrate) that is based on the transmission parameters 

that you specify here will cause the selected file's rate (Source Bitrate) to overflow, the 

Useful Bitrate value will be displayed in red. In this situation, the selected file will not 

be generated correctly, so change the transmission parameters until the Useful Bitrate 

value is displayed normally (in black). 
 

 

Figure 5-28  TS Setting dialog box 
 

• Modulation Setting 

Set the transmission parameters of the selected Source (Fixed Pattern, PN, or 

transport stream file). 
 

System 

Select the broadcasting system. [ DVB-S / DVB-S2 ] 
 

Modulation 

Select the modulation method. 

DVB-S: [ QPSK 1/2 / QPSK 2/3 / QPSK 3/4 / QPSK 5/6 / QPSK 7/8 ] 

DVB-S2: [ QPSK 1/2 / QPSK 3/5 / QPSK 2/3 / QPSK 3/4 / QPSK 4/5 / 

QPSK 5/6 / QPSK 8/9 / QPSK 9/10 / 8PSK 3/5 / 8PSK 2/3 / 

8PSK 3/4 / 8PSK 5/6 / 8PSK 8/9 / 8PSK 9/10 / 16APSK 2/3 / 

16APSK 3/4 / 16APSK 4/5 / 16APSK 5/6 / 16APSK 8/9 / 

16APSK 9/10 / 32APSK 3/4 / 32APSK 4/5 / 32APSK 5/6 / 

32APSK 8/9 / 32APSK 9/10 ] 
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Roll-off (only when DVB-S2 is selected) 

Select the roll-off factor. [ Alpha 0.35 / Alpha 0.25 / Alpha 0.20 ] 
 

Symbolrate 

Set the symbol rate. The unit is Msps. You can set the value to four decimal places. 

Enter the value in the text box, or use the slider to set the value. [ 1.0000 to 35.0000 ] 
 

Pilots (only when DVB-S2 is selected) 

Select whether pilots are used. [ Enable / Disable ] 
 

FEC frame (only when DVB-S2 is selected) 

Displays the frame length (normal). You cannot change this value. [ 64800 bit ] 
 

• TS parameters (Only valid when a transport stream file has been selected) 

TOT Overwrite 

Select this check box to overwrite the TOT (Time Offset Table) in the TS according to 

the PC time settings. [ On / Off ] 

* This setting is not valid if there is no TOT in the TS. 
 

PCR Update 

Updates PCR when transport streams are converted to framed transport streams with 

TMCC. This is fixed at "on." [ On ] 
 

Null Packet Filter 

Filters any packets that have the 0x1FFF PID from the TS.This is fixed at "on." [ On ] 
 

• Range (Only valid when a transport stream file has been selected) 

Select this check box to specify the playback range. Use the numeric keypad or the 

sliders to set the Start and End times. 

If you set the range, and then select a different TS, the Range check box will be 

cleared. Clear this check box to play the TS file from its start to end. [ On / Off ] 
 

* If the bit rate cannot be calculated from the TS file, the bit rate is set to a fixed value. 

Note the following regarding the TS playback range. 

• The displayed time is calculated from the detected bit rate and the file size. Depending on 

the data, there may be a small degree of error in this calculation. 

• The minimum time unit that you can use to specify the time is 1 second. The time setting is 

automatically calculated for packets. 

• If an incomplete data byte exists at the start or end of the data, the LG 3860 ignores this 

data fraction and plays data back in units of packets. 

 

● Parameters 

Parameters are not used on the LG 3860SER02. 
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5.6 Sub Window 

 

Figure 5-29  Sub window 
 
5.6.1 Frequency 

Set the the output frequency. 

Enter the value in the text box, or use the slider to set the frequency. 
 
5.6.2 RF 

Turn signal output on or off. 

 
5.6.3 Level 

Set the level of the output signal. 

Enter the value in the text box, or use the slider to set the level. 
 
5.6.4 Noise 

Turn noise on or off. 

 
5.6.5 C/N 

Set the C/N. 

Enter the value in the text box, or use the slider to set the level. 
 
5.6.6 Output 

Set the output signal to modulation (MOD) or carrier (CW). 
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6. APPENDIX 

6.1 Channel Number Table 

The network ID, TS-ID, and service ID when a fixed pattern is selected are shown below. 
 

Table 6-1  Channel number table 

Network ID 
Service ID 

(Channel Number) 

Hexadecimal Decimal 

TS-ID 

Hexadecimal Decimal

Network Name Service Name 

000A 10 0x3007 8257 
33367

(599) 
スカパー！HD サービス スカパー！インフォ

 



 

 

Following information is for Chinese RoHS only

LG 3860SER02

此标志适用于在中国销售的电子信息产品,依据2006年2月28日公布的

《电子信息产品污染控制管理办法》以及SJ/T11364-2006《电子信息产品污染

控制标识要求》，表示该产品在使用完结后可再利用。数字表示的是环境保护使

用期限，只要遵守与本产品有关的安全和使用上的注意事项，从制造日算起在数

字所表示的年限内，产品不会产生环境污染和对人体、财产的影响。

产品适当使用后报废的方法请遵从电子信息产品的回收、再利用相关法令。

详细请咨询各级政府主管部门。

产品中有毒有害物质或元素的名称及含量

部件名称             有毒有害物质或元素    Hazardous Substances in each Part

Parts 铅 汞 镉 六价铬 多溴联苯 多溴二苯醚

(Pb) (Hg) (Cd) (Cr(Ⅵ)) (PBB) (PBDE)

本体部 × ○ ○ ○ ○ ○

备注）

  ○：表示该有毒有害物质在该部件所有均质材料中的含量均在SJ/T11363-2006 规定的限量要求以下。 

  ×：表示该有毒有害物质或元素至少在该部件的某一均质材料中的含量超出SJ/T11363-2006 

  　　标准规定的限量要求。

Ver.1

  所含有毒有害物质信息
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